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 Introduction 
 

1.1 Pre-requisites 
 
If you are installing DF15 hardware you must perform the following tasks:  
 
Choose an appropriate installation location. 

Manage your own personal safety and safety of other personnel and the public.  

Assemble the required equipment and organize/implement Traffic Management 
arrangements. 
 
Have experience installing electrical equipment at height. 
 

1.2 Important Safety Information 
 
Please review the following information before installation. 
 

Warnings 
 

READ ALL INSTRUCTIONS BEFORE USE AND SAVE THIS MANUAL FOR FUTURE 
REFERENCE 

 
DF15 units must be installed and adjusted in accordance with the installation 

instructions contained in this Handbook 
 

Use the DF15 only for the applications it was designed and supplied for 
 

Changes or modifications not expressly approved by Unipart Dorman could void any 
warranty or guarantee on the equipment 

Safety Information 
 

The following safety information and warnings enable you to avoid potential harm to yourself and others; 
and possible damage to the equipment, being installed/maintained 
 
This should not be considered to be an exhaustive list of hazards you may encounter during with the 
equipment and should never be considered as a substitute for your judgment and experience. 
 
Please read and observe all the safety information and instructions contained in this 
manual before installing or operating any equipment. You should keep this handbook in a 
safe place for future reference. 
 
If you are unsure about any part of this installation or of the potential hazards listed, please contact 
Unipart Dorman immediately using the details at the back of this handbook. 
 
This section contains important information to help you recognize, understand and mitigate some of 
the risks involved with installing and maintaining a DF15 sign. 
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To reduce the risk associated with electric shock injury. 
 
Operate any AC isolation equipment fitted to support structures. 
 
Open the white fuse barrels located on the DIN Rail illustrated in section 2.3.1 to isolate 
the equipment within the sign. 
 
All electrical equipment must be serviced by suitably qualified personnel. Specifically, 
someone with previous training or who has received factory training on these or similar 
types of equipment, such that they thoroughly understand the techniques, tools, and 
methods required to properly service this equipment. 
 
Qualifications should be valid where there is a time expiry clause attached to them. 
 
Battery acid may cause skin irritation and eye injury. To reduce the risk of burns or other acid related 
injury resulting from handling lead-acid batteries: 
 
Wear approved gloves, goggles, and an apron when handling batteries 
 
Beware of cracked battery cases 
 
Handle batteries with care. 
 
Always use the recommended charging systems. 
 
To reduce the environmental risks associated with the improper disposal of batteries containing lead and 
acid: 
 
Please dispose of batteries in strict accordance with all national and local 
government laws/regulations. 
 
Radar Radio Frequency (RF) energy can be harmful to the eyes. 
 
To reduce exposure to the risk of RF energy, do not stare into the Moving vehicle detector 
(MVD) radar antenna. Maintain a minimum safe distance of 20cm (8- inches) from display 
face. 
 
An accidental short circuit may instantly heat conductive jewelry, tools, etc to skin-burning temperatures.  
 
Keep tools, jewelry, and other conductive objects away from the battery terminals 
and/or live equipment. 
 

To reduce the risk of impact hazards resulting from falls, accidents with passing vehicles, and from unstable 
equipment: 
 
Use appropriate traffic control methods, work equipment, and procedures.  

To reduce the risk of strain or back injury, always use proper lifting techniques and have 
adequate help. Strong consideration should be given to the use of mechanical lifting 
equipment such as cranes during installation. 
 
Be certain the sign is mounted to an appropriately rated pole or equivalent mounting 
surface. 
 
Use appropriately rated mounting hardware. 
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NOTICES 
 
This equipment has been tested and found to comply with the limits for a class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates and can radiate radio frequency energy and, if not correctly installed 
and used in accordance with the instructions provided, may cause harmful interference to 
radio communications. 
 
Changes or modifications not expressly approved by Unipart Dorman could invalidate any 
warranty. 
 

1.3 Scope of this Document 
 

This documentation provides the following information for DF15 
 
Setup and Operation 
 
Troubleshooting 
 
Installation of DF15 hardware may require that you work above the ground on a ladder or access device. 
Please make sure you have all the required equipment and are aware of potential safety issues before 
starting any installation. DO NOT install any DF15 hardware if you are unsure how to complete the 
installation or lack appropriate safety equipment. 
 
Unipart Dorman does not recommend installing this hardware during inclement weather. 
 
Every effort has been made to ensure the accuracy of the information given in our Publications, but in 
accordance with our policy of continually improving our products we reserve the right to modify designs 
and specifications whenever necessary.  
 
Every care is taken to ensure that, as far as reasonably practical, equipment supplied will perform without 
risk to health. It is essential that accepted codes of professional practice are followed in the assembly, 
installation and commissioning of the equipment. If in doubt with respect to any of these instructions, 
please consult Unipart Dorman before installing the device. Unipart Dorman reserves the right to vary or 
modify any specification without prior notice. 
 
Please note that equipment and components described in this document are protected by patent and no 
part of this document may be reproduced in any form without the written permission of Unipart Dorman. 
 

1.4 Description 
 
 
DF15 are electronic vehicle speed activated LED road side signs which are directly targeted, and proven to 
have an effect on road safety. 
 
The sign provides a digital speed feedback display and user selectable ‘Slow Down’ or ‘Slow 
Ice’ warning legends coupled with flashing amber LED Beacons in each corner of the sign. 
 
The sign is supplied with front fixed plate fascia with YOUR SPEED in black lettering on a choice of 
diamond grade reflective fluorescent yellow, yellow green or white backgrounds. 
 
Unipart Dorman DF15 signs are available with a speed data logging analysis feature which allows the user 
to collect speed data at the sign site. The data logger can be operated with the sign in both covert and 
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operational mode which allows the user to collect ‘before’ and ‘after’ data for performance evaluation 
purposes. 
 
A second set of activation trigger points can be applied in school zones where a lower speed limit is 
required to be enforced at peak times of the day. This allows active reinforcement of separate speed limits 
at user specified times. 
 
Signs are supplied with either Solar only or dual AC/Solar plug and play compatibility to suit both urban 
and rural site applications. 
 
The DF15 Sign is fully compliant with the FHWA Manual for Uniform Traffic Control Devices (MUTCD) 2009 
Edition and meets the minimum requirements detailed in Section 2B.13 Speed Limit Sign (R2-1) Clause 20. 

 
The DF15 can be configured to deliver a speed warning message that is in direct relation to how far the 
speed limit is being exceeded. E.g. 2mph above speed limit - display speed solidly, 
5mph above limit - display speed solidly with flashing beacons, 10mph over limit - display Speed 
alternating with SLOW DOWN, 15mph over limit - display SLOW DOWN with flashing beacons. 

1.5 Schematic Diagram 
 

 
Shown overleaf is a schematic diagram which depicts the interfacing of the various components which go to 
make up a DF15. On solar only versions, the AC Supply, Post Isolator and AC to DC Converter are omitted; 
and correspondingly on AC Power versions the Solar Panel, Solar Controller and batteries are omitted. 

An additional Float Charger which can charge the batteries using an external AC source may also be specified 
for areas of poor sunlight capture or very high traffic volumes. Please contact Unipart Dorman for more 
information. 

 

 

 

 

This space intentionally blank 
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2. Installation 
 
Prior to Installation commencing it is highly recommended that the installer undertakes a site survey 
evaluation and a full health and safety risk assessment covering installation, operation and maintenance. 

2.1 Installing DF15  
 
Mark a chalk line on the post at 7 ½ ft/2.28m from ground level (level with the road surface). 
This will be the position for the bottom of the sign. For optimum alignment the sign display face should be 
pointing at the center point of the approach traffic lane at a range of between 300ft (92M) and 500 ft 
(150M) distance from the sign. In the case of a dual lane approach, use the dividing center line of both 
approach lanes. (The radar sensitivity may be adjusted to suit local conditions if required by following the 
instructions shown in section 5.8) 

 
Failure to align the radar correctly may affect radar performance. 
 
Signs are delivered with Signfix Channeling as the mounting hardware and are installed with ¾” / 19mm 
banding using SX0220 banding adaptors. Unipart Dorman recommends that dual bands should be used on 
the top and bottom mounting points to add extra strength. The sign can also be affixed using Signfix U 
brackets for ease of frequent dismantling and re-deployment of the DF15. 
 
It should be noted that the preferred mounting method in Florida is to use pre-drilled Z section and U Bolts 
as detailed in FDOT Design Standard 11860, which should be consulted before installation commences. 
 

2.2 Installing the Solar Panel 
 
Prior to physical mounting of the solar panel, it is recommended that the separately provided plug and 
play solar power lead is connected to the Solar Panel junction box. 
 
The bracket is assembled using the instructions included in the bracket packaging. 
 
The spacing between the two cross members which attach to the post should be set at 18” / 457mm. This will 
give an angle of approximately 45 degrees from the panel to the vertical support post. The angle of the panel 
can be adjusted if required for seasonal solar changes, i.e. 30 to 45° in summer. >45° in winter. 
 
The bottom cross member of the side of pole bracket should be mounted approximately 12” (305) mm 
above the top of the sign. 
 
 Please note: The Solar panel should be aligned to be facing directly south and have a clear 360 degree 
view of the sky. It is important to avoid any shadowing by trees or tall buildings. 
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Typical Solar Panel Arrangement 

 

2.3 Electrical Hook Up 
 
 
All DF15 can be supplied as standard with either Solar only or Dual AC/DC (Solar) functionality, 
allowing clients the flexibility to select an appropriate power source to suit each DF15 site location. 
 

2.3.1 DC Solar Hook up 
 
 
Actions to install: 
 
Open the sign with access key provided 
 

Open all fuse barrels located on the internal power din rail by pulling each fuse carriage open: 
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Physically clamp all 20 amp/hr 12v battery cells into position in the compartment provided internally 
within the bottom section of the DF15 
 
 

 
 

Battery 
Clamps 

 
WARNING 

 
On Dual AC/Solar devices, if the sign is to be solar powered it is essential that the fuse in 
position F2 is removed 
 

Connect the sign wiring harness to the batteries, connecting the Red to Positive (+) and Blue to Negative (-) 
using the cable links provided to connect all batteries in parallel. 
 
The supplied lead connects at one end into the solar panel junction box and at the other to the rear of the 
sign via an IP65 plug/socket arrangement. 
 
Open the junction box on the back of the solar panel by undoing the 4 retaining screws. Fit the ½” / 13mm 
plastic cable gland, feed the cable through the gland and terminate to the screw terminal connections. 
Finally, hand tighten the gland to ensure weatherproofing. 
 
Important Note: 
 
It is essential that the correct polarity of all connections is maintained to prevent possible 

damage to the system. 
 
The plug end of the cable fits into the 2 pin socket on the rear of sign marked Solar Panel. Align the key and 
guide built into the plug and socket, and screw down the plug securing ring fully to ensure proper fitment 
which ensures the NEMA Standard 4/IP65 ingress rating. Ensure dust caps are fitted to all unused sockets 
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Note: Solar Only Signs are supplied with a blanking bung fitted in place of the upper AC Hookup point 
 

Important Note: Ensure polarity of the connection lead is correct by proving with a meter 
before connecting the sign to the solar panel. 

 
The fuse carriages can now be closed. The installer should note that the red LED1 on the DF15 control card 
will flash to indicate that the system is being powered correctly. 
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The installer should also at this point take note of the LED indicators on the SunSaver charge controller 
located within the sign: The green ‘charging’ LED will light whenever sunlight is available and indicates 
that the battery reservoir is being charged correctly. The green LED will extinguish at night. 
 

 

 
The Red ‘Load Disconnect’ LED will light to indicate that the charge controller has automatically 
disconnected the DF15 where the battery charge is very low in order to prevent potential damage. The 
controller will automatically turn the DF15 back on once the battery charge has returned to acceptable 
levels Solar Power connection is now complete and the DF15 is ready for sign configuration 
parameters to be set and deployment. (See section 3) 
 

2.3.2 AC Hook Up (Where supplied) 
 

Actions to install: 
 
Open sign with access key provided 
 
Open all white fuse barrels located on the internal power din rail by pulling each fuse carriage open as 
shown in the section on solar hook up above 
 
WARNING 
 
If the sign is to be 110V AC powered it is essential that the fuse in position F3 is removed 
 
Two AC 110V entry points to the sign are available to the client: 
 

 



13    
C64.64161 Issue 6 

 

Option 1 
 
Via the NEMA Standard 4/IP65 rated Plug and Socket at the rear of the sign. 
 
 

Or 
 
Option 2 
 
Via ¾” / 19mm entry hole drilled for a ½” / 13mm flexible conduit (not supplied) which is located on the 
rear of sign (supplied blanked off with rubber blanking grommet) 
 
Important Note: The following items are to be conducted by an Approved Electrician 
 
Option 1.  Install a 3 core, 1.5mm PVC covered armoured flexible cable, terminated at one end into the 
NEMA Standard 4/IP65 Plug, and at the other connected to a fuse isolated external local AC 110V supply 
(5amp minimum). 
 
Option 2. Fit an approved outdoor armoured flexible conduit (not supplied) between the sign conduit 
entry point and the fuse isolated external local (5amp minimum) AC 110V supply.  
 
Install a 3 core, 1.5mm PVC covered flexible cable via the conduit between the external local (5 
amp minimum) fuse isolated 110V AC supply and the internally labelled 110VAC F1 supply input 
fused screw terminal (it will be necessary to disconnect and stow the pre-connected cables leading 
from the 3 pin socket to the fuse block). 
 
Strip back each core 6mm and connect the green earth core into the terminal marked  (the middle 
terminal), connect the black core to the live fused terminal and connect the white core into the neutral 
terminal. DF15 signs will operate from 100 -110V AC single phase supply. Internal Fuse rating is 3.15A and 
is of the Time Delay variety. 
 
IT IS ESSENTIAL THAT ALL THE TERMINATIONS AND CONNECTIONS ARE FULLY INSULATED 

AND THAT NO CURRENT CARRYING CONDUCTOR IS LEFT EXPOSED 
 
Follow the same instructions as per above to connect into the local external fuse isolated supply 
(provided by others). Connectors required are dependent on the type of isolator that has been installed. 
Close all fuses and ensure the red LED on the main controller board flashes continuously as shown in 
the solar instructions above. 
 
AC Power connection is now complete and the DF15 is ready for sign configuration parameters to be set. 
 

2.3.3 Float Charger Hook Up (Where supplied) 
 
In areas of poor sunlight capture characteristics or where traffic volumes mean the battery 
power is expended too readily, an additional float charger may be specified. This unit hooks into 
a street lighting circuit to provide additional charging capacity during the hours of darkness.   
 
The schematic diagram below illustrates the connection arrangement inside the sign. The Live 
feed should be connected via the fuse block and a 3.15 Amp slow blow fuse to the Brown cable; 
the Earth/Ground cable to the Green and Yellow; and the Neutral to the Blue cable  
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2.4 External Flashing Beacon 
 
 
An external 12V DC flashing LED Beacon such as the model shown below can be fitted and controlled by 
the DF15 sign controller. The Beacon is designated to flash constantly unless the sign is set in covert mode 
using either the Timetable function or an external selector switch.  

 

To allow the control function to be used, a 12V feed (+) should be taken from the WAGO power rail 
connector as marked by the red arrow in the view below through the Beacon and into Conn 12 on the Sign 
Control PCB as shown by the green arrow. 

  
 
 
 

Dual Solar/AC version shown for reference 
 
 
Simplified, the circuit will be: 
 

12V Supply (+)  Beacon  Conn 12 (-) 

3.0 Configuration and Setup 
This section provides a guide to configuring of the DF15 once physical and electrical power supply 
procedures have been completed. 
 

3.1 Setting Normal/Covert  Mode 
 

The DF15 Signs have the ability to operate in both active and stealth modes for data logging purposes. 
When first installed it is normal to set the sign in stealth mode to allow before speed data to be 
collected. Once a suitable amount of stealth data is collected the sign may be switched to active mode 
and data collection continued. 
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Collecting data in this way will allow the operator to evaluate the performance of the signs. The data 
collection process is covered in more detail in section 4. 
 
Stealth mode is simply selected on the PDA/Laptop by unticking all the speed parameters. 
 

3.1.2 Setting Normal/Covert  Mode Using External Switching 
 
Customers may if they wish utilize an external control means to switch the sign between Normal and 
Covert modes. 
 
The switch unit should be connected to the main DF15 Control PCB using the screw down terminals for 
Input 2 and GND as illustrated below. 
 

 
 
 

3.2 PDA Software 
 

The PDA will come pre-loaded with DF15 software. This software is specific to the DF15 sign and will not 
operate in conjunction with Unipart Dorman VATCS. 
 

3.3 DF15 Data Logger 
 

This  raw  data  may  be  downloaded  from  the  sign  to  a  hand  held  PDA/Laptop  operating  the 
Datalogger application software via a wireless Bluetooth connection, where it can then be 
manipulated  in  Microsoft  Excel  to  allow  the  operator  to  attain average,  percentile  and percentile 
ranking of speeds. 
 
More information on the functionality of both the Datalogger, Scheduler and VAMP Desktop 
applications are covered in the remaining sections of this guide. 
 

4.0 Operating Instructions (PDA) 
 
To run the DF15 data logger application on the supplied PDA, select the start menu and select DF15 
V1.3 program shortcut in the drop down menu, this will run the program and will allow the operator to 
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establish a connection to the sign, configure the sign parameters, set the real time clock, request a 
status report, download speed data and upload timetable schedules. 
 
Please note that it is not possible to alter the radar sensitivity using the PDA and this must be done from 
a PC/Laptop etc over the Bluetooth connection. 

4.1 Initial Set Up 
 
Go to the start page on the PDA and click the small blue icon on the bottom right of the display. This 

brings up the Bluetooth page. 

 

The large circular button underneath the word “Bluetooth” should be green as shown on the screen 
illustrated. If it has a red cross striking through it, then Bluetooth is turned off. Clicking the button will 
turn it on and clicking the button again will turn Bluetooth back off. 

Click the OK button at the top right hand side once you have finished 

 

 

Set the PDA Time by clicking on the Start menu>Settings 
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Then after selecting the System Tab at the bottom of the screen click on Clock and Alarms 
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Set the Home Time Zone and correct time using the dropdowns. The unit will automatically compensate 
for daylight saving. Then accept the changes. 

              

 

From the Start Menu please select the DF15 v1.3 Operating Software as shown 

 

Once you have done this, click the CONNECT button. Please note that you will need to be within 15 feet of 
the DF15 sign in order for the Bluetooth™ to pick up a signal. 
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You will now be presented with a screen asking you to select a Bluetooth device similar to the one on 
below. 

It may take a few seconds for the software to locate all surrounding Bluetooth devices.  

 

 

A connection to a sign will appear here as an icon with a name that will be your unique Unipart Dorman 
Project No YYYY--XXX” where YYYY is project number and XXX is the no of the sign. 

E.g. 4321-001 



20    
C64.64161 Issue 6 

 

 

To connect to the sign, select it on the screen and press the OK button. This will take you to the next 

screen where you will need to enter the Pairing Code/Passkey 0000 

 

Upload the Real Time Clock Setting if required using the screen shown. (Instructions on setting the RTC 
are shown further back in this section) 

 

 

 



21    
C64.64161 Issue 6 

 

4.2 Setting Speeds 
 

First select the SPEEDS tab at the bottom of the screen and then toggle between KPH or MPH using the 
radio buttons. 

To set the sign in Stealth Mode untick all the speed selection boxes. 

The Get Speed button will obtain the values currently set in the sign.  

 

 

The speeds can now be set by ticking the relevant box and then adjusting the value in the box by clicking 
on the up or down arrow. 

‘Activation Speed’ is the value at which if exceeded will trigger the sign to display a steady indication of 
the vehicle’s approach speed. 

‘Notification Speed’ is a higher value which if exceeded would cause the speed to be shown accompanied 
by the flashing Beacons. If the Beacons are disabled using the Options Tab the display will flash the 
vehicle approach speed at the driver. 

‘Slow Down Speed’ is the next speed increment and above this value the display will alternate between the 
approach speed and the SLOW DOWN legend. Also, if the Beacons are enabled they will flash. 

The Max Speed setting will disable the speed feedback to the driver to prevent the sign being used for 
‘highest score’ competitions. However the Slow Down legend and Beacons (where enabled) will still flash. 
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4.2.1 Example Settings  
 

Any Combinations of settings can be employed:  

This combination would cause the sign to feedback a steady display of approach speed from 30, until 45 
when the speed read out would cease. The Slow Down legend and Beacons (where enabled) will still 
flash. 

 

This following combination would cause the sign to go straight to a speed feedback display plus flashing 
Beacons at 45. (where the Beacons are disabled the display would flash) At 50 the display would alternate 
between the speed display and the SLOW DOWN legend; and at 55 the display would change to the SLOW 
DOWN legend only with flashing Beacons where selected. 
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4.3 Setting the ICE warning 
 

First select the ICE tab at the bottom of the screen and then toggle either Celsius or Fahrenheit radio 
buttons. 

Then click SET and use the slider to set the threshold temperature. 

The GET TEMP Button will retrieve the parameter already set in the sign. 

 

 

 

When the value is set ticking the Enable ICE Warning box will set the parameter into the sign. 

The SLOW DOWN Legend which would normally be triggered is replaced by the SLOW ICE warning when 
the temperature drops below the set threshold. 

The screen will confirm that the transfer was successful by a ‘Temperature Was Set’ dialogue appearing 
above the Tabs. 

4.4 Retrieving Log Files 
 

To retrieve a log file, you first need to enter a name for the file that the log file will be stored in*. 

In order to do this, click the box at the top of the display labelled “Filename” and then click the keyboard 
icon at the bottom of the display. 

This will display a keyboard which you can use to enter the filename. 

*For example XXXX.MMDDYYYY Where XXXX is a unique sign identifier and MMDDYYYY is the date. 
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Then click on “Get Log” and the download should begin. 

Note: 

Depending on the size of the log being downloaded this may take several minutes. If the logs are taking 
too long to download, then consideration should be given to increasing the frequency the signs are visited 
at to download smaller files.  

 

 

4.5 Deleting a Log File 
 

To delete the log file from the DF15, Type the Password LOGCLR into the Filename box then click the 
CLEAR LOG button. DELETING THE LOG IS A ONE CLICK OPERATION AND IS 
PERMANENT. THE LOG FILE CANNOT BE RETRIEVED ONCE YOU HAVE DELETED IT. 
The system automatically begins to log data in a new file after the previous log has been deleted. 
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4.6 Options 
 

Clicking on the Options Tab will allow you to set some unique options to enhance the signs operation. 

Get Options will download the Options already set in the sign. 

Ticking the Beacons Enabled box ensures that where the correct parameters are set all relevant displays 
will be accompanied by the Beacons in each corner of the sign flashing in alternating horizontal pairs. 

The Activation Timer allows the user to set a time delay measured in seconds between initial detection of 
a vehicle travelling above the preset trigger speed and the illumination of the display. 

The Reactivation Timer allows the setting of a delay in seconds between sign activations when for instance 
there is a stream of traffic approaching the sign, all travelling above the trigger speed. This will separate 
the Speed Feedback into distinct events which will indicate to drivers their individual speed.  

Careful consideration of the Activation and Reactivation Timer settings can allow savings to be made in the 
power consumption.  

Toggling between Standard and Power Saving on the brightness option allows the brightness of the 
displays to be reduced slightly independent of the automatic dimming facility, and can be used to preserve 
battery life in solar powered signs. 

The combination of setting Activation/Reactivation times and selecting Power Saving can return significant 
power consumption savings. 
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6.12 Transferring a Timetable to a DF15 (PDA Only) 
 

Once a timetable file has been created on a Laptop/Desktop and saved, it can then be uploaded to one 
or more DF15 signs. To do this, the timetable file needs to be transferred to the supplied PDA so that it 
can be uploaded to the sign wirelessly. 
 
To copy Timetable files to a PDA, the PDA must first be synchronized with the PC where the timetables 
are saved. This is achieved using Microsoft Active Sync/Windows Mobile Center (supplied with the PDA). 
 
If Active Sync/Windows Mobile Center is not already installed on the PC then it should be installed from 
the disk that was provided in the PDA’s packaging. Please refer to Microsoft’s documentation for details 
of how to install Active Sync/Windows Mobile Center. Once Active Sync/Windows Mobile Center is 
installed, the PDA must be connected to the PC via the USB cable which was supplied with the device. 
After connection, Active Sync/Windows Mobile Center will automatically attempt to synchronize with the 
PDA. If you have already configured Active Sync/Windows Mobile Center to recognize and synchronize 
with your device, then connect as normal. Alternatively, you can choose to connect as a guest.  
 
Next click the button marked Explore. This will open a window, entitled Mobile Device which displays 
the PDA’s file system. With this window still open, open a new window and locate the previously saved 
timetable file(s) you wish to upload. 
 
Select the file(s) required and either copy and paste or drag them to the Mobile Device window. You 
may be asked if you wish to copy the files to your PDA in which case, confirm the transfer. This 
transfer process will store the timetable files in the My Documents file on the PDA. 

 
First tap the Timetable tab and then tap SELECT on the PDA screen. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
This will bring up a file browser which will indicate any .vtt files that are stored in the My Documents 
file of the PDA. If the .vtt file you wish to use is in another directory then you may need to navigate 
to that directory to locate the file. To choose which file to upload, simply tap on the appropriate 
filename from the list. This will begin the upload process. A progress bar will appear showing the 
status of the upload process. The PDA will indicate when the transfer is complete. 
 
Once Uploaded, to enable the timetable, simply tap the button, ENABLE. If no timetable has currently 
been uploaded, the PDA will return an error. Similarly, to return the sign to its default, non-switching 
mode, the timetable stored can be disabled. To disable the timetable, tap the DISABLE button. 
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4.7 Exiting the PDA Program 
 

From the Link Tab at the foot of the screen, select Disconnect to close the Bluetooth link to the sign and 
then click Exit. This should return you to the PDA HOME Screen. 

 

4.8 LDR and Advanced Tabs 
 

There are additional Tabs at the bottom of the screen labelled LDR and Advanced. These are for use by 
Unipart Dorman only and are password protected. 

 

 

 

 

 

 

This space intentionally blank 
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5.0 Operating Instructions Laptop/Desktop 
 

Please consult your device’s operating instructions for the method of detecting and pairing with a device 
using the Bluetooth communication system. Should your device ask for a pairing code for the VATCS, 

please enter 0000 which is the default setting for all units and is factory set. 

Unzip and install the VATCS Setup software, where prompted accept and run the software and you will be 
presented with the Setup wizard which will guide you through the rest of the installation process .  
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If you are using Windows 7 (or earlier versions of Windows) From the Start Menu please select the DF15 
Control Panel v1.32 Operating Software as shown: 
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If you have Windows 10, in the Start Menu select All Apps and Programs then open the Unipart Dorman 
folder. Find the DF15 Control Panel and double click to run it: 

 

 

Initially, you will be presented with this screen: 

 

Using the dropdown, select which Serial Port you will be using for Bluetooth communications and once you 
have done this click the CONNECT button.  

Please note that you will need to be within 15 feet of the DF15 sign in order for the Bluetooth™ to pick up 
a signal. 

5.1 Setting Speeds 
 

First select the SPEEDS tab at the top of the screen and then toggle between KPH and MPH using the 
radio buttons 

To set the sign in Stealth Mode untick all the speed selection boxes 

The ‘Get Speeds’ button will obtain the values currently set in the sign. If there are no speeds set in the 
sign this button will be grayed out. Similarly the ‘Set Speeds’ button will also be grayed out until changes 
are made to the parameters and these are ready to be transmitted to the sign. 
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The speeds can now be set by ticking the relevant box and then adjusting the value in the box by clicking 
on the up or down arrow. 

‘Activation Speed’ is the value at which if exceeded will trigger the sign to display a steady indication of 
the vehicle’s approach speed. 

‘Notification Speed’ is a higher value which if exceeded would cause the speed to be shown accompanied 
by the flashing Beacons. If the Beacons are disabled using the Options Tab the display will flash the 
vehicle approach speed at the driver. 

‘Slow Down Speed’ is the next speed increment and above this value the display will alternate between the 
approach speed and the SLOW DOWN legend. Also, if the Beacons are enabled they will flash. 

The Max Speed setting will disable the speed feedback to the driver to prevent the sign being used for 
‘highest score’ competitions. However the Slow Down legend and Beacons (where enabled) will still flash. 

Examples of different combinations can be seen in the PDA section above. 

5.3 Retrieving Log Files 
 

To download a log file , hit select button to create a file name under a directory of your choice on your PC, 
by clicking on file name to save the file , you will be taken back into the program where you can hit use 
the get log button and download the data into the same file 
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Note: 

Depending on the size of the log being downloaded this may take several minutes. If the logs are taking 
too long to download, then consideration should be given to increasing the frequency the signs are visited 
at to download smaller files. 

5.4 Deleting Log Files 
 

To delete the log file from the Sign, type the Password LOGCLR into the Filename box then click the 
CLEAR LOG button.  (This button will remain greyed out until a log file is available for deletion). 

 

DELETING THE LOG IS A ONE CLICK OPERATION AND IS PERMANENT. THE 
LOG FILE CANNOT BE RETRIEVED ONCE YOU HAVE DELETED IT.  

The system automatically begins to log data in a new file after the previous log has been deleted. 
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5.5 Options 
 

Clicking on the Options Tab will allow you to set some unique options to enhance the signs operation. 

 

Get Options will download the Options already set in the sign. 

Ticking the Beacons Enabled box ensures that where the correct parameters are set all relevant displays 
will be accompanied by the Beacons in each corner of the sign flashing in alternating horizontal pairs. 

The Activation Timer allows the user to set a time delay measured in seconds between initial detection of 
a vehicle travelling above the preset trigger speed and the illumination of the display. 

The Reactivation Timer allows the setting of a delay in seconds between sign activations when for instance 
there is a stream of traffic approaching the sign, all travelling above the trigger speed. This will separate 
the Speed Feedback into distinct events which will indicate to drivers their individual speed.  

Careful consideration of the Activation and Reactivation Timer settings can allow savings to be made in the 
power consumption.  

Toggling between Standard and Power Saving on the brightness option allows the brightness of the 
displays to be reduced slightly independent of the automatic dimming facility, and can be used to preserve 
battery life in solar powered signs. 

The combination of setting Activation/Reactivation times and selecting Power Saving can return significant 
power consumption savings. 

5.6 Timetable Management 
 

Before this option is available a Timetable must be created using the V-AMP software. This is covered 
elsewhere in Section 6.0 of this Handbook. The three buttons enable you to select which timetable to use 
and whether it is in use or not 
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5.7 Setting the Ice Warning 
 

First select the ICE tab at the top fo the screen abd then toggle to either Fahrenheit or Celsius. The GET 
TEMP button will retrieve the threshold temperature set in the sign. 

Simply click on SET and using the sider control set the trigger threshold temperature.  When this 
temperature is detected by the sign, the SLOW DOWN legend is replaced by a SLOW ICE warning. To set 
this temperature in the sign please check the Enable ICE Warning box. 
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5.8 Adjusting the Radar Sensitivity 
 

Certain site conditions may require the radar sensitivity to be altered from the standard factory setting.  

Select the Radar tab and enter a percentage value of between 1 and 99, then click the “Set Sensitivity” 
button  to update the new setting to the sign.  

The table shown can be used as a guide to determine the sensitivity setting. (By default all radars are 
programmed to 40%). 

 

 

 

 

 

 

 

 

 

 

5.9 Exiting the Program 
 

The program is exited after selecting the ‘Link’ tab and then clicking on ‘Exit’  
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6.0 Setting a Timetable 
 
 

6.1 Introduction 
 
 
V-AMP is Unipart Dorman’s switching timetable editing application designed to work with DF15 Signs. V-
AMP provides tools for designing timetables to instruct the sign to automatically change display modes. 
Timetables created using V-AMP can then be uploaded to one or more DF15 wirelessly using the 
supplied PDA via a Bluetooth connection. 
 

6.2 Overview of Timetable System 
 
 
V-AMP provides a simple method of creating a switching timetable for your DF15. Each timetable 
created using V-AMP will contain, as a minimum, a base timetable. The base timetable is a weekly, 
Monday to Sunday timetable which will repeat every week of every year. 
 
For each day of this weekly schedule, up to 10 sign switchovers can be defined. A single switch-over 
defines a time at which the sign should change and to which preset parameters it should change to. 
 
Often a weekly schedule repeating throughout the year is inappropriate for a sign’s intended application. 
A common example of this is the occurrence of school holidays. V-AMP provides tools to allow periodic 
alternatives to the base timetable. Once a base timetable is defined, V- AMP allows up to 40 alternative 
time periods to be defined. 
 
 

Between the dates defined by an alternative timetable, V-AMP will override the base timetable and 
instead switch the sign using the schedule defined for the alternative period. An alternative period can 
be defined in the same way as the base timetable by creating a weekly schedule which will repeat 
during the defined period. 
 

6.3 Creating a Timetable 
 
When the V-AMP application first opens, the user is presented with the following menu screen, 
select the DF15 button. 
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A blank timetable is presented and this allows you to begin editing straight away. If a timetable is 
already open, a new timetable can be created by selecting File>New Timetable from the menu bar. If 
the current timetable has unsaved changes, you will be prompted to save, ignore or cancel. 
 

6.4 Creating a Base Timetable 

To create the base timetable for your schedule, click on the Base Timetable tab. You will be presented 
with a blank schedule table as shown above. 
 

 

 

 

6.5 Adding a Switch-Over to a Schedule 
 
To add a switch-over, first click the ‘Add Switch’ button. 
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A new window will appear as shown below, giving the various options relating to the switch. The switch-
over can be applied to multiple days during the weekly schedule by checking the boxes for the required 
days. The ‘All’, ‘Weekdays’ and ‘Weekend’ buttons provide a quick method of selecting days. 
 
To set the time at which the switch over is to take place, select the appropriate hours (hh) and minutes 
(mm) from the drop down boxes. Finally, using the ‘Switch Sign To’ dropdown, select the state to switch 
the sign to. 

 

 

6.6 Removing a Switch-Over from a Schedule 
 

To remove a switch-over from a schedule simply click on its entry on the schedule table to highlight it 
in blue as shown below and click ‘Delete Switch’. 
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6.7 Creating an Alternative Timetable 
 
When an alternative to the weekly base timetable is required, an alternative timetable period can be 
defined. To create an alternative schedule, select the Alternative Timetables tab within the main 
application window. This tab will present the list of currently defined timetables. 

 

 

 

6.8 Adding an Alternative Schedule Period 
 
To define a new period in which to enable an alternative schedule, first click Add Period as indicated 
by the arrow above. This will present the window shown below. A beginning 
and an end date can be selected using the drop down calendars provided. Click Add Period to 
add the new dates to the list. 
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NOTE: A newly defined period may not overlap an already defined period. If the dates provided coincide 
with another alternative period then a warning will be given and different dates must be selected. 

6.9 Creating an Alternative Schedule 
 
Once the dates for an alternative period have been defined, the period will appear in the alternative 
period’s table. To define the daily switchovers for the alternative period, click on its entry in the list. 
This will display the schedule for that period in a new schedule table as shown below. Browsing this 
schedule as well as adding and deleting switchovers can be performed in exactly the same way as for 
the base timetable. 
 
NOTE: Alternative timetables can also be used to define periods where no switching is required. Simply 
leaving an alternative timetable without any switchovers defined will instruct the DF15 to remain in its 
default state for each day defined by the alternative period. 
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6.10 Removing an Alternative Schedule Period 
 
To remove an alternative schedule period from the list, click on its entry in the period list and click Delete 
Period. 

6.11 Custom Setting Alternate Trigger Speeds 
 
A second set of activation trigger points can be applied if required, for example in school zones 
where a lower speed limit is required to be enforced at peak times of the day. 
 
To set the primary and secondary speed triggers, select the Speed Trigger tab as shown in the screenshot 
below by the arrow and then select each individual speed parameter by clicking on the drop downs as 
shown. 

 

 

7.0 Repair & Maintenance 
 

It is recommended that routine maintenance is carried out at six monthly intervals as detailed below. This 
period may need adjusting depending on the conditions of use and should be revised after each 
maintenance visit. 

7.1 Visual Check 
 
Visually check the enclosure and screen, including the case seal for damage. Repair and replace as 
necessary. Check the cabling to the enclosure is secure and undamaged. Repair or replace as necessary. 
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7.2 Enclosure Cleaning 
 
Clean the enclosure and front screen with a cloth with mild detergent solution. Abrasive materials or 
solvent based cleaners should never be used.  

7.3 First Line LRU Maintenance. 
 
The DF15 family series have no field maintainable components and have been modularly designed so that 
should any fault occur with the sign. The trained client maintainer may replace/remove the faulty LRU 
(line replaceable unit) for return and repair.  
 
The DF15 series of signs is made up of the following LRUs: 
 
Si-3 Radar 
DF15 Controller Card 
DF15 PSU 
DF15 Display Modules (display specific) 
SS6 Charge controller 
80W Solar Panel   
12V 20amphr battery 
 
It is recommended the client maintains a spares holding of LRUs commensurate with the quantity and 
types of DF15 model deployed to ensure minimum downtime of any DF15 due to failure.  It is also 
recommended that the client maintainers are trained in the operation and maintenance of the DF15 to 
ensure a long and trouble free life.  
 
Note: All failures due to manufacturer defects will be replaced or repaired at no cost to client during 
warranty period. Full warranty details are available on request.  
 
The DF15 have no field maintainable content. However, a trained maintainer may quickly diagnose the 
fault and replace the modular item causing it.  
 

7.4 Replacing Components 
 
After observing all normal safety precautions and considering any traffic management requirements, 
access to the inside of the sign should be made from a stable working platform.  
 
The sign interior should be examined for any signs of water ingress or excess condensation and the 
enclosure door seal should be examined for integrity. Any evidence of water accumulation should be 
investigated and remedial action taken. 
 
Before any work is carried out on the sign which does not require the sign to be powered up, the sign 
should be electrically isolated by withdrawing the fuse barrels located on the DIN rail as shown below. 
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7.5 Replacing the Control Board 
 

After locating the Control Board, all cables linking it to the rest of the sign should have their positions 
carefully noted and then be disconnected by undoing the grub screws securing the cables to the board. 
(Please note that the picture above is a representation of a control board installation and colors/positions 
of cables may differ)    
 
Remove the four cross head screws in the corner of the board and lift it out. 
 
If an MMC Card as shown by the red box below is fitted to the board, it will need to be transferred to the 
replacement board during fitment. Also the Bluetooth dongle as shown by the green box below will need 
to be transferred between the old and new board. 

 
 
 

 
 
 
Restore power by refitting the fuse barrels, and ensure the red indicator LED on the control board (ringed 
in orange above) flashes approximately once every second.  
 
When the control board is replaced it will be necessary to carry out the initial set up as shown in 
Section4.0/5.0 and reinstall any timetable information.  If the radar sensitivity was altered from the factory 
setting at initial installation or if you are unsure please see section 5.8 to check and adjust as required. 
(The radar sensitivity cannot be accessed with a PDA).  
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7.6 Replacing the MVD 

 
After Locating the MVD, first trace the cable run around the sign, and then disconnect it from the sign at 
the disconnection break seen below removing cable ties as required. 
 
 
 

 
 
 
 
 
 

 
 
 
 
The MVD head can then be removed from the support bracket using a 3/16” Allen Key.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fitment is a reversal of removal. It should be noted that if the insulating washers indicated in the pictures 
below are not fitted, and an earth path is created, the MVD will not function and may suffer irreparable 
damage.                                                     
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Insulating washers 
must be refitted 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
The cable should be tidied and cable ties fitted as required.   
 
Restore power by refitting the fuse barrels, and ensure the red indicator LED on the control board is 
illuminated.  
 
Replacing the MVD does not alter the radar sensitivity setting   
 

7.6.1 Replacing the MVD (Houston Radar only) 

 
The Houston Radar unit does not have the convex end cap and is mounted in the support bracket using the 
two cross head screws. Otherwise replacement is the same procedure as the Decatur Radar with the 
exception of the requirement to fit insulating washers. 

 
 

 
 

 
Replacing the MVD does not alter the radar sensitivity setting   
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7.7 Replacing the LED Arrays 
 
There are a variety of displays fitted in many variants of sign but essentially the arrays are secured using 
simple nut and bolt fasteners. Note the position of any washers fitted and ensure they are replaced in the 
same order. 
 
Electrical connection is achieved by using screw down terminals as shown below in the red boxes 

 
 

 
 

 
 
 Please note cable identification may vary with build standard and to ease reconnection Unipart Dorman 
strongly advise the marking of each cable position prior to disconnecting. 

 
 
 
 
 
 
 
 
 
 
 

This space intentionally blank 
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7.8 Fuse ratings and position 
 

Fuse F1 
 
 
 
 
 
 
 
 
 
 
 
 
 
This fuse protects the equipment against AC supply voltage anomalies and is a time delay fuse rated at 3.15 Amps 
 
 
Fuse F2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fuse F2 protects the control board where supplied from the AC-DC PSU and is rated at 5 Amps (Time Delay) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fuse F3 
 
 
 
 
 
 
 
 
 
 
Fuse F3 protects the control board where supplied from the SunSaver 10 Solar Controller and is rated at 5 Amps (Time Delay) 



48    
C64.64161 Issue 6 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fuse F4 
 
 
 
 
 
 
Fuse F4 protects the battery supply and is rated at 10 Amps (Time Delay) 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fuse F5 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fuse F5 protects the battery supply and is rated at 10 Amps (Time Delay) 
 

7.9 Radar Performance 
 
If there are problems where the sign is triggering  late or fails to trigger when the approaching vehicle is 
clearly exceeding the set speed, consideration should be given to clearing all significant radar energy 
reflectors from within the radar footprint.  If the problem persists, please see the instructions for adjusting 
the radar sensitivity in section 5.8 or contact Unipart Dorman for further advice.  
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8.0 PDA Software Application Troubleshooting 
Here are some answers to some common problems that may be encountered during use of the 
Communicator software. 
 
After Selecting the Bluetooth Connection to the Sign, the Software Does Not Reappear On the Display 
 
If this occurs, the PDA does not have Bluetooth turned on. Please see the section “Establishing a 
Connection to the Sign” on how to do this. 
  
Keyboard Icon Does Not Appear On Software 
 
When trying to enter a name for the log file, the keyboard icon has not appeared in the bottom right hand 
corner of the screen.  
 
To fix this, go to STARTSETTINGS and select the SYSTEM tab. Click the MEMORY icon and then select 
the RUNNING PROGRAMS tab. In the list you should see “Unipart Dorman Sign”, click this and then click 
the ACTIVATE button. The keyboard will now be available in the software 
 
Sign Remains Connected to the PDA after Closing the Software 
 
When you have exited the software, the dongle connection light remains on, meaning that the software 
has not disconnected from the sign. The problem here is that the software is still running in the PDA 
memory, usually because you exited the software via the X button rather than the EXIT button. 
 
 
To fix this go to STARTSETTINGS and select the SYSTEM tab. Click the MEMORY icon and then select 
the RUNNING PROGRAMS tab. In the list you should see one or more “Unipart Dorman Sign” entries. This 
is the DF15 Communicator software. Click each one of these entries and click the STOP button to remove 
them from memory. Next turn the Bluetooth on and then off (See the “Establishing a Connection to the 
Sign” section). 
 
The Bluetooth Device Selection Screen Does Not Appear When You Click the CONNECT Button. 
 
The PDA by default is set to display a device selection screen as it is searching for Bluetooth devices. 
However, the setting may have been turned off which would prevent this screen from appearing when you 
clicked CONNECT. 
 
To fix this, follow the instructions for determining the outbound communication port settings found in the 
section “Establishing a Connection to the Sign”. On the screen displaying these settings, check the box 
stating “Default Device for outgoing serial connections...” This causes the device selection screen to be 
displayed. 
 
Other Problems 
If you have any other problems with the software, resetting the PDA will get the DF15 software back into 
its original state. To do this, use the PDA pen to press and hold the small button at the side of the PDA. 
The PDA should take a few moments to reset. 
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9.0 Troubleshooting Flowcharts 
 

The flowcharts provided at the end of this User Guide are not exhaustive but are designed to 
provide some guidance to fault finding. 

10.0 Glossary of Terms 
 

 

AC             Alternating Current 

Amp/Hr    Amperes per Hour  

CD             Compact Disc 

DC             Direct Current 

Hz              Hertz 

IP (65)      Ingress Protection Rating 

KPH           Kilometers per Hour  

LRU           Line Replaceable Unit  

M               Meter 

MMC/SD  Memory Card Variants 

MPH          Miles per Hour 

MVD          Moving Vehicle Detector (Radar Unit)  

PDA          Personal Digital Assistant 

PSU             Power Supply Unit 

RF               Radio Frequency  

RTC             Real Time Clock  

V                 Volt 

W                Watt 
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